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Notes from the Chair 

Dear LES Members, 

As the former Editor of Biblio-Notes, I admit that it is a daunting task to be on 

the other side of the newsletter business. Instead of gathering articles from 

members, I am charged with writing the greeting to all of LES. Well, I can 

definitely say that I am so proud to be a member of such an impressive group 

of information professionals and am excited about leading LES through a year 

of promising programs.  

Having our Annual conference in Las Vegas was certainly a fun way to 

jumpstart my role as Chair. Along with SEES and WESS, our section sponsored 

the special program entitled: “Embedded” Cultural Communities in Europe and 

the Americas: Challenges for Librarians. The speakers addressed the challenges 

that libraries and librarians face seeking to collect and preserve the language, 

literature, and cultural heritage of different cultures. Focusing on Basque, 

Romani, and Native American cultures, the panel examined embedded 

communities and discussed how librarians can successfully build collections around their needs. A bibliography 

that includes resources on librarians and embedded communities is available from the LES Wiki at 

http://literaturesinenglish.pbworks.com/w/file/81984239/EmbeddedCulturalCommunitiesinEuropebibliography

.pdf  

At the annual General Membership program, members of LES spoke 

about the different career paths they followed and told some 

enlightening stories about how to make the most out of your career in 

literature librarianship. The General Membership gathering is a good 

venue to meet new librarians and learn about ways to become more 

involved in professional service. Also, if you are a student or are new to 

the humanities profession, you should consider joining the mentorship 

program. A mentor can guide you through challenges at work, point you to networking opportunities, and help 

you navigate the often-overwhelming conference experience. The nature of the mentor-mentee relationship 

varies with the participants, and communication might take place over e-mail, social media, telephone, or in 

person. To request a mentor or to volunteer as a mentee, fill out the online form at 

http://www.ala.org/acrl/aboutacrl/directoryofleadership/sections/lesmentors.  

Photo provided by Laura Taddeo 
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Conference planning never stops! Midwinter preparation is in full swing and will be held mostly virtually for our 

section. Stay tuned for more information on collections and reference discussion group meetings. Holding 

Midwinter virtually allows more members to participate, since it eliminates the burden of travel costs and time 

commitments away from the office. For those able to travel to Chicago, I will try to arrange an in-person social 

hour for LES members. Meeting with colleagues face-to-face over deep-dish pizza is something to look forward 

to! Announcements of Midwinter meetings will be made via LES-L, ALA Connect and our social media platforms.  

Speaking of social media, don’t forget to join the LES Facebook page 

https://www.facebook.com/groups/202772333122825 where we post LES news, photos and interesting 

updates on Literature related topics. It is a good networking tool. You can even follow news through a Twitter 

account https://twitter.com/LES_ACRL. 

Along with the ARTS section, LES will be co-sponsoring an Emerging Leader. The American Library Association 

(ALA) Emerging Leaders (EL) program “is a leadership development program which enables newer library 

workers from across the country to participate in problem-solving work groups, network with peers, gain an 

inside look into ALA structure, and have an opportunity to serve the profession in a leadership capacity. It 

puts participants on the fast track to ALA committee volunteerism as well as other professional library-related 

organizations.” Selections will be announced in late fall. LES will also be continuing the sponsorship of a Modern 

Language Association (MLA) representative. I am happy to announce that Sarah Wenzel will serve an additional 

three year term (until 2018). As the MLA liaison, Sarah received funding to attend the Annual MLA convention 

and help plan the MLA discussion group Libraries and Research in Languages and Literatures. Having the MLA 

liaison encourages the collaboration between literature faculty and librarians. In the future, LES hopes to 

sponsor liaisons from additional higher education societies and organizations. 

The 2015 Nominating committee, chaired by Christine Ruotolo, has gathered another excellent slate of 

candidates for Vice Chair/Chair-Elect, Secretary, and Member-at-Large. Be sure to cast your vote during the 

spring elections. If you want to become more involved in the section, please consider volunteering for one of the 

LES committees: conference planning, membership, nominating, planning, publications, and virtual 

participation. Discussion groups are another way to stay involved. The discussion forums held during Midwinter 

and Annual tackle issues such as management, preservation, or use of materials in English-language literatures. 

My service on the publications and membership committees certainly helped me grow professionally. Amanda 

Rust, Vice-Chair/Chair-Elect, will be placing a call out to all of LES members at the beginning of next year for 

volunteers. To read more details about specific committee functions, visit the service page at 

http://www.ala.org/acrl/aboutacrl/directoryofleadership/sections/les/committees/lescommittees  

 

Some current projects committee members are working on include providing practical collection development 

tools, such as weeding guidelines for literature librarians and an updated statement on the preservation of 

primary materials. Both finished products will help librarians deal with the challenges posed by today’s digital 

learning environment. 

 

I am so grateful to all of LES’s committee members for their hard work. I would also like to express my sincere 

gratitude to out outgoing Chair, Arianne Hartsell-Gundy, for her wonderful leadership and enthusiasm. I look 

forward to having another productive and fun year collaborating with our dedicated LES members! 

https://www.facebook.com/groups/202772333122825
https://twitter.com/LES_ACRL
http://www.ala.org/acrl/aboutacrl/directoryofleadership/sections/les/committees/lescommittees
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Laura Taddeo 
Humanities Librarian 
University at Buffalo 
ltaddeo@buffalo.edu 
 

 

 
 
 

Kickstart the Future of ACRL 
 
You definitely know that we are celebrating ACRL's 75th Anniversary. You probably know that ACRL was ALA's 

first official division. You might know that Phineas L. Windsor was first president of ACRL as a self-governing 

division. I hope you know that to celebrate and honor this Anniversary ACRL is conduct a major fundraising 

campaign to raise money for scholarships to ACRL 2015. ACRL seeks to raise $50,000 by December 31, 2014, to 

provide 75 additional scholarships for these members to attend the conference to be held March 25-28, 2015, in 

Portland, Oregon.  

 

We’ve already raised more than $33,000 during the 

advance phase of the campaign. Now we invite you to 

pay it forward and invest in the profession’s future 

leaders (and their libraries) as they seek to advance 

learning and transform scholarship in the 21st 

century. With your contribution (of any amount), we 

can ensure the future vitality of the profession, the 

association, and the diversity of our conference. 

 

This is also a great opportunity for ACRL committees, sections and groups to show their support by establishing 

group scholarship goals. Some of those that have already established group goals include: the College & 

Research Libraries Editorial Board, Distance Learning Section (DLS), Education and Social Sciences Section (EBSS), 

Literatures in English (LES), Rare Books and Manuscripts Section (RBMS), Research and Scholarly Environment 

Committee, Science and Technology Section (STS), University Libraries Section (ULS), and the Value of Academic 

Libraries Committee. A page on the 75th Anniversary website acknowledges all group contributions. We have 

made great progress towards our goal but we are not there yet. Please consider making an individual donation 

or encourage your group to get together to fund a scholarship or commit to achieving 100% Board participation. 

For more information on how to get involved visit the Scholarship Campaign FAQ page at 

http://acrl.ala.org/acrl75/?page_id=278. Help ACRL kickstart the future with your contribution.  

 

Steven Bell, ACRL 75th Anniversary Campaign Chair 

 
 

http://acrl.ala.org/acrl75/?page_id=278
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A First-Timer at ALA 

After landing a tenure-track position as James Madison University's English Liaison Librarian in August, 2013, I 

was given the opportunity to attend my first American Library Association Convention. The 2014 ALA 

Convention in Las Vegas, Nevada, which ran from June 26th to July 1st, was jam-packed with thrills. I saw Mr. 

Excelsior himself, Stan Lee, give a talk in front of a packed house. I got to meet two-time Academy Award-

winning actress Jane Fonda (who signed for me a copy of her latest book). I ran into many old friends and 

colleagues. I also ate at a few of the city's famous buffets and walked the hot streets of Sin City until the soles of 

my shoes melted, passing an army of Elvis impersonators along the way. 

As a first-timer just entering the field of academic librarianship, I found ALA 2014 to be an invigorating 

experience. Aside from the usual perks of conferences—the exhibition spaces, the informative panel discussions, 

the keynote events, and the after-hours meet-ups at local watering holes—ALA 2014 gave me the opportunity 

to meet with my counterparts at colleges and universities all across the United States. 

The first session I attended was the LES New Members Discussion Group on Saturday, June 28th. Here I got to 

meet, for the first time, librarians like myself, both new to the profession and with a background in literature. 

Prior to entering the profession of librarianship, I received a Ph.D. in English (specializing in post-World War II 

multi-ethnic American literature) and had taught for four years as a Visiting Assistant Professor of English at 

Oklahoma State University (home institution to David Oberhelman, who currently serves on the Planning, Virtual 

Participation, and Conference Program Planning Committees). At the New Members Discussion Group, I heard 

from several librarians who shared a similar academic past as well as an ongoing commitment to literature. 

Hearing their stories and concerns was professionally reassuring. Following the session, a cadre of LES members 

met up at the Peppermill Lounge, a Las Vegas diner and bar decked out in glorious, leisure suit-ready 70s kitsch. 

Here I met more LES-ers, the discussions ranging from collection development to pop hits of the 1980s. 

Sunday was loaded with events. At the Reference and Collection Discussion Groups, issues pertaining to 

information literacy sessions, promoting one's services, database subscriptions, and funding (or the lack thereof) 

were broadly discussed. I was able to chime in, feeling at ease with my new colleagues, as they elaborated on 

what I had shared with them. There was also an LES Career Paths panel, featuring long-time LES members who 

ascended the ranks in their libraries and universities to become deans and heads of academic units. The panel 

illustrated that LES librarians are well prepared and can be many different things professionally if they seize the 

opportunity. On Monday, I attended the All Committees meeting, where I learned what my role would be in the 

Publications Committee (which I was nominated to serve on in the spring). We talked for a good forty-five 

minutes about our web resources, Biblio-Notes, and an aging LES pamphlet, which I was tasked with updating. 

Aside from LES-related activities, I also attended sessions pertaining to Shared Print platforms, Digital 

Humanities, and an RBML Discussion Group on Collection Development, which were all extremely informative. 

All told, my 2014 ALA experience was an overwhelmingly positive one. I was able to bring back to my university 

plenty of new knowledge to share, as well as sense of being part of a welcoming new community of colleagues. I 



5 
 

even got to meet many of my LES colleagues from Virginia! I encourage all new librarians, whether involved in 

LES or not, to experience everything that the annual ALA Conference has to offer. 

Brian Flota 

Assistant Professor 

English Liaison Librarian 

James Madison University 
flotabc@jmu.edu 

 
 

Biblio-Throwback! 
 

[The more things change, apparently, the more they stay the same. Here’s an excerpt  
from the meeting minutes at ALA Annual in Dallas, back in 1984. ] 

“As boundary-spanners, subject specialists have to establish a rapport with the teaching faculty 
and be willing to represent the needs of the faculty as well as the values and policies of the 
library. Communication across organizational boundaries is essential. In a serials deselection 
project, both librarians and teaching faculty bring together the facts and judgments necessary to 
determine which titles should be cancelled and both groups are forced to question entrenched 
assumptions about the responsibilities of academic librarians. It is more difficult for both 
librarians and teaching faculty to know a library's journal collection than its monographic 
counterpart. Subject specialists can evaluate older, established journals through use studies, 
citation analysis, circulation figures, etc., while they must rely on teaching faculty for judgments 
about periodicals not yet in the mainstream. While the boundary-spanning experience gives 
librarians and faculty new perspectives, cancellations can alienate faculty and undermine their 
trust in the library's ability to serve their needs.” 

 
 

 

Member News 
 
Nancy Foasberg published “Student Reading Practices in Print and Electronic Media” in the September, 2014 

issue of College & Research Libraries. 

 

Colleen S. Harris-Keith joined CSU Channel Islands as Assistant Librarian and Information Literacy Coordinator. 

In addition, her latest poetry chapbooks, Madwoman City and Some Assembly Required are currently in-press 

with Porkbelly Press. 
 

 

mailto:flotabc@jmu.edu
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Modifying Public Domain Posters 

Introduction 

Libraries tend to have plenty of printers but not much in the way of a graphic design budget, meaning that 

library posters and fliers often have a dull or amateur quality about them. This makes sense, since few if any of 

us are trained graphic designers. 

There is a way, though, to take advantage of wonderful graphic designs from the past by repurposing them for 

library use. Scrubbing the existing text off of an old public domain print or poster and adding your own can 

provide an eye-catching effect and help bring vanishing arts like lithography into the digital age. 

Many sites host public domain artworks, and many graphics editors can be used to manipulate them, but this 

demonstration uses the Library of Congress and GIMP 2.8 because the LoC is much more diligent about 

copyrights and scanning techniques than many other places and GIMP 2.8 is free and open-source. 

 

Obtaining the Image 

 Go to the Library of Congress Prints & Photographs online collection at loc.gov/pictures. [Fig. 1] 

 Limit your search to "Larger image available anywhere" 

 Find a print or poster that looks good and click on its title. 

 Check the publication date and rights advisory to make sure the item is in the public domain. Virtually all 

items returned from a "Larger image available anywhere" search are either pre-1923 works digitized by 

the Library of Congress or later works published by the government (and therefore "born public 

domain"). For this example, we'll use an old American Library Association poster intended for World 

War I doughboys. [Fig. 2] 

 Download the highest-resolution version of the print or poster available. This is typically a TIFF file, and 

they range from being large (5 megabytes) to very large (50 megabytes). Remember to left-click to 

download, as most web browsers will not open TIFF files. 

 

Cleaning the Image 

 Open the TIFF in a graphics editing program like Photoshop or GIMP. GIMP, which is open-source and 

free to use, is pictured. [Fig. 3] 

 Choose the Color Picker tool or equivalent (it has an icon like an eye dropper) and click on an area you 

would like to clean. This will select a color from that area to work with. Don't click on the words you 

want to delete, but on the color surrounding them. 

loc.gov/pictures
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 Choose the Fuzzy Select tool or equivalent (it has an icon like a magic wand) and click on the same area. 

It will select all similar colors in that area. Again, don't click on the words you want to delete, but on the 

color surrounding them. [Fig. 4] 

 Create a new layer using the "New Layer" menu option from the "Layers" menu. This will create a 

transparent layer on top of the image, keeping it intact in case you make a mistake. 

 With the similar colors selected and a new layer created, fill the selection with color using the "Fill" 

command. In GIMP, the "Fill With FG [foreground] Color" command from the "Edit" menu is your best choice. 

 Still working on your new layer, select all the letters using the "Rectangle Select" tool (it has an icon like 

a rectangle with a dotted border). Then, use the "Fill" command again (be careful to stay away from the 

edge of the area, as you want to preserve the original fading of one color into another). [Fig. 5] 

 You should have a fully clean area at this point. 

 Repeat the process with other areas you wish to modify. It's best to start with posters that have discrete 

text boxes, as more complex modifications take more practice. [Fig. 6] 

 

Cropping and Resizing 

 To prepare the image for printing, there are a few additional steps. First, select the area you want to be 

printed with the Rectangle Select tool. Then choose "Crop to selection" from the "Image" menu. This will 

get rid of the Library of Congress scanning table and color guide. [Fig. 7] 

 Once the image is cropped, choose "Scale Image" from the "Image" menu. 

 In the resulting dialog box, change the "Image Size" display from pixels to inches. 

 In the same box, change the resolution to 300 pixels per inch, which is a print-quality resolution most 

color printers are capable of matching. Notice that changing the resolution also alters the "Image Size" 

in inches – this is important, as you will need to make sure that the image will fit on the piece of paper 

you want to print it on. 

 Since this image is just a little above 8.5 inches wide—wide enough to fit on an 8.5x11 sheet of paper—it 

can be modified just a little further by changing the width to exactly 8.5. A good rule of thumb is to 

make either the length or the width of your poster equal to 8.5 or 11 inches to aid in printing. 

 You're now ready to add whatever text you like to the poster. You can use the Text Tool (which looks 

like an uppercase "A") to draw text on the image. Remember to select a color different than the 

background. GIMP defaults to pixel widths instead of font points for typing, so change it to display 

points (pt) if you want to draw on your old-school knowledge of 12-point and 72-point fonts. [Fig. 8] 
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Optional: Noise and Blurring 

 If you want to take an extra step to blend the old and new parts of your print or poster together better, 

you can do that. Choose the layer or layers you created to cover the original poster text, and hit control-

A or choose "Select All" from the "Select" menu. [Fig. 9] 

 Then open the "Filters" menu and choose "Noise." 

 You will have the option of several noise types, but "RGB Noise" is the best option. You can adjust the 

balance of colors, but I like using a mix of 20 percent red, green, and blue. [Fig. 10] 

 If you look at your image, this appears to add ugly static to it. But there's a point to this. 

 Go back to the "Filters" menu and this time choose "Blur." The "Blur" command added to the "RGB 

Noise" makes the new area look just like old paper that's been scanned, and it fits in with the 1918 

original document almost perfectly. This trick can be used to recreate the look of old paper almost 

anywhere! 

 

Saving 

 The last thing to do is to export your file as a compact JPG or PNG file. Many printers cannot handle TIFF 

files, so this is essential. Go to the "File" menu and select "Export As." [Fig. 11] 

 Choose "JPEG" as the file type. Don't forget to add the .jpg to the end of the file name, as GIMP makes 

you do this manually. 

And you're done! This poster will print out 8.5 inches wide and a little shorter than 11 inches, so you'll have 

some empty space on the paper for a letterhead or to cut off. The same process can be used for virtually any 

high quality image you can find! 

Alex Watson  
Reference Librarian and Associate Professor  
University of Mississippi  
apwatson@olemiss.edu 
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Fig. 7 
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Fig. 11 

 
 
 

 
 

 

Apply by Nov. 11 to Host ACRL 2015  

Scholarly Communication Workshop as Road Show 

Today’s academic and research librarians increasingly act as change agents in the higher education community. 
Nowhere is this more true than in the realm of open access and scholarly communication. To help empower our 
community in accelerating the transformation of the scholarly communication system, ACRL is once again taking 
its popular scholarly “Scholarly Communications: From Understanding to Engagement” workshop on the road to 
five locations in 2015. The day-long workshop is led by two expert presenters at locations across the country, 
and the content is updated annually to meet the evolving needs of the community. 

The program continues its cost-sharing model as ACRL is committed to underwriting the bulk of the expense for 
delivering the road show, and the cost for successful host institutions is $2,000. The application to host is now 
available. Apply by Tuesday, November 11, 2014, at 5pm Central. Find out more on the program website at 
http://www.ala.org/acrl/issues/scholcomm/roadshow. 

In addition to the competitive subsidized version, you may bring this one-day workshop, at full cost, to your 
campus, chapter, or consortia year round. 

http://www.ala.org/acrl/issues/scholcomm/roadshow
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Did You Know? 

ACRL members can view full contact information for all ACRL section committee rosters 

(http://www.ala.org/acrl/aboutacrl/directoryofleadership/sections) by logging into the ACRL Web site.  

 

 
 
 

The End of the Ink: Those Awkward Books 

 
There was a time, not too many decades ago, when our libraries were quieter. Library technologies were more 

stable. The research processes of our patrons looked much like they had for centuries. Whatever the efficiencies 

of microforms or changes wrought in U.S. universities by the G.I. Bill, the library was recognizable as such. 

 

To say that libraries have changed in recent years would be boring and obvious, so I will not say it. What I will 

say is that these changes have hit us, as literature librarians, and our patrons working in the humanities, harder 

than some of our librarians in other areas. However accustomed social sciences librarians might have been to 

providing service using print journals, they put them aside when the time came and did not look back. Nobody in 

or serving computer science programs is regularly forced to justify holding on to a city block's worth of IBM 

Punched Cards in order to pass the minimum test to support the discipline. The same is not true for us. 

 

By our nature, most of us have some lingering affection for physical media (print, vinyl, whatever), so we have 

personal reasons to love our collections. By our profession, however, by service to the community of patrons 

devoted to literature, we find ourselves defending slow, careful, ruminative styles of research that require 

resources that are awkward and bulky, only periodically used, and not well-suited to libraries that rotate around 

coffee shops, flash mobs, glass and brushed aluminum, and "student space" (as if students had not always come 

to libraries, as if they had not always found some essential solace there).  

 

For many of us, journal prices are passing out of the exorbitant and into the absurd, physical collections are 

going off-site, and "good enough" search is displacing the precision that once was our stock in trade. These and 

related things are here, or coming, and we all know how congenial these developments are to the humanities. 

Every year at Annual, we talk about how to meet our patrons' needs in an environment where sophistry is 

regularly used to demonstrate that browsing is bad, subject headings are impossible to use, black is white, or 

whatever the current fashion is in bibliographic self-deprecation. 

 

Against these tides, however, remember Ranganthan: every reader her book. The other laws are fine, and 

justifiably held up to defend sea changes in how we serve patrons, but: the book. Ask your patrons what they 

http://www.ala.org/acrl/aboutacrl/directoryofleadership/sections
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need from their library, and take notes. When there are surveys and focus groups, make sure our people get the 

word. Humanities research rarely gets the kind of headlines that come to STEM-H, and our people's needs 

sometimes look, at this particular moment in libraries' evolution, a little bit strange, and unlike that of everyone 

else. And that is all right—as long as we remind everyone who must hear it that saying this work—this human 

work—is at the heart of the academy rings hollow if we cannot provide an environment that supports the work. 

 
John Glover 
Humanities Research Librarian 
Virginia Commonwealth University 
jglover2@vcu.edu 
 

 
 

Editorial information 

Biblio-Notes is a biannual electronic publication of the Literatures in English section of the Association of College 
& Research Libraries, a division of the American Library Association. To submit articles, photos, announcements 
or news items, please contact the newsletter editor, John Glover, at jglover2@vcu.edu. 

© American Library Association, 2014. 
 
ACRL  
50 East Huron Street 
Chicago, IL 60611  
(800) 545-2433, ext. 2523 
www.acrl.org 

mailto:jglover2@vcu.edu
mailto:jglover2@vcu.edu
http://www.acrl.org/

